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1 Identification of Delivery

 This delivery contains the nessessary files to install updates to  the Columbus Ground System (CGS)  CI
Number  1214 597, in its version  CGS_V4.5.1 . PDB checkpoint: CGS_4.5.1.3

The version includes fixes to a number of corrections to overcome problems reported in SPRs (see chapter
2). It also includes some functional  extensions (see chapter 6)

The delivery comprises a  delta CGS system (Service Release) with  the following components:

  o  CGSI

  o  CLS

  o  CSS

  o  DBS

  o  FWDU

  o  GWDU

  o  HCI

  o  MDA  / MDB_V4_5_0

  o  NWSW

  o  SWES

  o  TES

  o  TSCV

  o  TEV

  o  TSS

  o  CGS_API

The  software has been verified running specific SPR regression testing as well as rerunning a subset of the CGS qualifi-
cation procedures as described in the Testreport, see chapter 3.7.



COL–RIBRE–TN–1197
Issue: 10 –
Date: 18.4.2002

Page: 2

Space Infrastructure

astrium

2 List of fixed SPRs

2.1  List of SPRs

SPRs fixed in this delivery and formally released:

   ID        TITLE                                                       PRODUCT

SPR–5422 array of WORD parameters treated incorrectly          CLS 
SPR–5891  Constrained pathname types as FLAP and LIB–routine para           CLS 
SPR–6352 Provide CCU Freeze and unfreeze functionality in SDDF     CGS 
SPR–6381 FWDU – Pathnames are lost in LIST & MENU DFDs      FWDU 
SPR–6852 can’t compile AP                 CLS 
SPR–7231 Over enthusiastic checking of point–pair calibration        MDA 
SPR–7455 After BDE export/import synoptics do not work         GWDU
SPR–7800 Communication Problems     CGS
      –> The remaining fixes (internal wrap ups) have only been included in CGS Version 5
      –> For CGS Version 4.5.1,however,  the problem can also be considered as closed.

SPR–7912 Workstation HCI has no visibility of testnode           CGS 
SPR–8311 MDB Report: CCU_VERSIONS_REPORT failure        MDA 
SPR–8399 Coupling between Synoptics and Enditem Definitions    GWDU  
SPR–8428 CDU deifference report does not detect changed date/time within one day  MDA 
SPR–8471 UCL Batch Compile didn’t Store I–Code in MDB     CLS 
SPR–8821 MDA: No CLS Batch Compile when missing BDE temporary SID Range     MDA 
SPR–8843 C SWEU/SWRU load functions ignore the MDB ownership concepts.   SWES 
SPR–8844 CGS load SWRU/SWEU in batch mode not usable    SWES 
SPR–8872 DDED: API_SET_STATUS_ERROR      MDA 
SPR–8900 FWDU – different behavior of DFDs with edit_cmd_popup     FWDU 
SPR–8901 FWDU – loss of onboard commands          FWDU 
SPR–8902 FWDU – unexpected behavior of select list DFD        FWDU 
SPR–8935 Waste of disk space                 TEV 
SPR–8936 FWDU: Select list DFD commands mixed and/or lost     FWDU 
SPR–8939 TEV: Old User Manual Displayed          TEV 
SPR–8949 TEV: Statistics Generation fails when disk is full TEV 
SPR–8991 No error status returned from DBS         DBS 
SPR–9024 UCL extension: statecode null value ($$)              CLS 
SPR–9032 Pathname dependencies not recognized by CLS Editor    CLS 
SPR–9150 Derived Parameter: incorrect i–code after I_MDB copy–paste   MDA 
SPR–9242 Missing data information CLS 
SPR–9387 BDE–CEI/I_MDB: End item naming constraints different   MDA 
SPR–9388 Missing batch compile function for ground synoptic displays   GWDU 
SPR–9457 Complete Message hidden in I_MDB window MDA
SPR–9502 Null pathname not stored into MDB aggregates    MDA  
SPR–9524 HCI: Synoptic display does not inherit default testnode from HLCL command window       HCI
SPR–9543 The selected execution session is not selected         TEV 
SPR–9613 CPL scripts: compilation fails for comparisions containing state code values   CLS 
SPR–9649 Missing functions for TRDB archive/export tools   DBS 
SPR–9671 dbs_central_exec : semop: REQUEST: Invalid argument  DBS 
SPR–9681 TSCV: Strange Refresh Operation TSCV 
SPR–9699 Lot of errors for FA when closing test session   DBS 
SPR–9754 BDE out data file generation          MDA 
SPR–9816 TES is hanging after opening a synoptic picture   TES
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SPR–9818 Session exported to non selected device        DBS 
SPR–9836 Exception Constraint_Error/Numeric_Error in p_data_processor   TES 
SPR–9842 Deadlock during Withdraw ADU Services   TES
SPR–9846 Unable to retrieve automatic final archived test sessions  DBS
SPR–9847 Manual final archiving of some test sessions not possible  DBS
SPR–9862 I_MDB: Copy/Move should reset compilation status for CLS end items MDA 
SPR–9932 Failed to setup test node in simulation mode   TES
SPR–9969 Selecting DFD causes FWDU crash   FWDU 
SPR–9987 I_MDB crash when leaving aggregate window    MDA 
SPR–9990 New CC: missing error messages in Post Processor   MDA
SPR–9991 New CC: wrong details shown for error message in postprocessor   MDA
SPR–9993 Failed to start the Automated Procedure on MTP    TSCV
SPR–10004 CGS consistency check CGS–ERR–102 does not work correctly   MDA
SPR–10007 Could not load SWRU                               SWES
SPR–10021 CLS Dependency Handler reports end item to be out of date, but it isn’t  CLS
SPR–10027 CLS installation raises error     CLS
SPR–10042 Problem in CSS library installation    CSS
SPR–10108 New CC: no report file without output on screen possible   MDA
SPR–10113 New CC causes delayed working in I–MDB and other input tools   MDA
SPR–10147 New CC crashes when pressing the right mouse button   MDA
SPR–10215 FWDU – wrong pathname in cross reference list    FWDU
SPR–10251 MDA: Unable to Retrieve MAX(LONG_REAL)   MDA
SPR–10253 CLS: Error after System Library Copy/Move    CLS
SPR–10254 CLS: Used Derived Value Item not Compiled with Make   CLS
SPR–10255 CLS: Inconsistent Cross References not Checked   CLS
SPR–10262 CLS: Batch Compile Misses Out Of Date Items    CLS
SPR–10279 Error in ”Check MDB Item” function    MDA
SPR–10323 New CC: Chosen item types erroneously evaluated from profile   MDA
SPR–10326 I_MDB crash when deleting used CCU version    MDA
SPR–10349 CC does not select the selected enditem    MDA
SPR–10403 MDA Data API Procedure Convert_CDU behaviour ambiguous   MDA
SPR–10411 CLS: UCL compiler does not accept DURATION as function return type  CLS
SPR–10416 FWDU swallows parameter and causes an error in the LAPAP MCD sofware.  FWDU
SPR–10417 FWDU enforces an empty parameter list     FWDU
SPR–10437 CLS batch compile/make tool is unable to store    CGS
SPR–10457 CLS editor make mode aborts with unexpected exception   CLS
SPR–10477 internal error: Exception TYPE_ERROR   CLS
SPR–10500 I_MDB: Crash  when trying to change ownership of CCU   MDA
SPR–10543 Checks CGS–ERR–10/–77 lead to abort of Consistency Checker   MDA 
SPR–10548 Invalid Type Conversion     CLS
SPR–10554 CLS/HLCL: Optional Semicolon Not Always Allowed   CLS  
SPR–10596 Multiplied number of end items in ground synoptic displays   GWDU 
SPR–10603 No support of local variables, aliases etc in HLCL    CLS  
SPR–10681 CLS batch compilation (forced) as CMUSER does not work   MDA 
SPR–10714 No support for nested command packets    CGS  
SPR–10775 S/W command blocks testnode     CGS  
SPR–10802 BDE CEI aborts with end item descriptions of 80 chars length   MDA  
SPR–10823 CSS not participating     TSCV  
SPR–10849 BDE does not check for consecutive entry numbers   MDA  
SPR–10880 Conversion (String of Byte) Failure    CLS  
SPR–10961 Difference Report Fails on CCU Comparison (2)    MDA  
SPR–10980 Wrong return status for procedure INIT_APPLICATION   TES  
SPR–11024 Export problem with splitting paramfile    MDA  
SPR–11031 GWDU background colour     GWDU  
SPR–11074 Start time of cls editor extremely increased after installation of p. 12     CLS  
SPR–11093 CLS Editor unable to work with references outside Owner CDU   MDA  
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SPR–11149 BDE cannot load NULL enumeration values    MDA  
SPR–11232 Change of SMT not recognized by front end equipment CGS  
SPR–11295 Extend CSS functionality implemented for SPR 9675   CGS  
SPR–11300 UCL: Wrong code for UNTYPED (parameterized pathname)   CLS  
SPR–11325 CLS_Editor Compiler found cyclic reference in up to now perfect AP  CLS

SPRs partially fixed in this delivery, and kept formally open for next delivery:

   ID        TITLE                                                     PRODUCT

 SPR–8927 UCL extension: ’string of BYTE’                    CLS

 SPR–9228 MDA: CCU EI XREF REPORT runs for days on APM configurations     MDA

 SPR–9866 Gap in TRDB event log (MetOp NCR 165)              DBS

 SPR–9922 TEV does not display GDU’s                         TEV

 SPR–9926 Inappropriate ioctl for device                     CGSI

 SPR–9978 trace back of SWRU End Items not possible          SWES

 SPR–9992 New CC: messages not appearing in the texteditor output in the postprocessor  MDA

 SPR–10096 Locking of enditems not complete                   FWDU

 SPR–10316 install_mdb.exec: ”unalias” Used Incorrectly       MDA

 SPR–10322 BDE–CU: Unable to create scope                     MDA

 SPR–10334 ’Permission denied’ error for recovery scripts after installation of CGS 4.3.1p15   CGS

 SPR–10426 missing CGS ICD for CGS 4.5                        CGS

 SPR–10551 Faulty consistency checker error messages (CGS–ERR–010)        MDA

 SPR–10710 CC CGS–77/78 take too long                         MDA

 SPR–10711 CC CGS–005 takes too long                          MDA

 SPR–10768 CC CGS–55 takes too long                           MDA

 SPR–10855 CC aborts during CGS–ERR–005 checks                MDA

 SPR–10978 MDBD 6.1.1 on Int1dbs (SIVQ Test Site 1) corrupted          MDA

 SPR–11414 Execution of AP which imports library before AP header raises exception  TES

                  

2.2  Covered Quick Patches

Several of the implemented SPRs have been provided as Quick Patches to CGS_4.5.0 already, but are now
formally released in this delivery. The following Quick Patches are included into CGS_V4.5.1:

 CGS_4.5.0P1 .. CGS4.5.0P16

2.3  List of Issues
Change–Issues implemented in this release.

Status               Author       CHANGE–ID              DATE      SYNOPSIS

refer to Attachment
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3 Documents

3.1 Installation Manuals

COL–RIBRE–MA–0025: CGS Installation Manual, Issue 4/H, 21.06.2001

3.2 User Manuals

COL–RIBRE–MA–0028: CGS User Manual, Issue 2/M,  30.05.2001

COL–RIBRE–MA–0030–00 MDA Introduction Manual,  Issue 3/B 4.4.1997

COL–RIBRE–MA–0031–00  MDA Reference Manual,  Issue 4/D 26.06.2001

COL–RIBRE–MA–0018–00 MDA Administration Manual,  Issue 4/B 31.03.2000

COL–RIBRE–MA–0037–00  DADIMA Introduction Manual,  Issue 3/– 4.4.1997

COL–RIBRE–MA–0032–00  DADIMA Reference Manual,  Issue 4/– 1.9.1997

COL–RIBRE–MA–0036–00 DADIMA Administration Manual,  Issue 4/– 1.9.1997

COL–RIBRE–MA–0032–00 SID Range Tool Users and Operations Manual,  Issue 1/– 15.09.1997

UM–114–001–ROV  GWDU User’s Manual and Operations Manual,  Issue 1.4  , 1999

UM–114–002–ROV  FWDU User’s Manual Manual, Issue 2.3 , 26.2.2001

3.3 Reference Manuals

COL–RIBRE–STD–0010 User Control Language (UCL) Reference Manual, Issue 4/A, 31.10.2001

COL–RIBRE–STD–0009 High Level Command Language (HLCL) Reference Manual,
     Issue 2/B 31.10.2001

COL–RIBRE–STD–0008 Reference Manual for Crew Procedure Language and Software,
     Commanding, Issue 1/E, 1998

3.4 Requirements Specifications

COL–RIBRE–SPE–0032  Columbus Ground System (CGS) Requirements Specification,
     Issue 6/C, 31.3.1999

3.5 Design Documentation

COL–RIBRE–ADD–0006  Columbus Ground System (CGS) Software Architectural Design
     Document, Issue 4/B, 30.10.1998
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3.6 Interface Definitions

COL–RIBRE–ICD–0069–00   MDB Standard Entities and Application Program Interface,
      Issue 4/C, 31.10.2001

COL–RIBRE–ICD–0025–00   System to CGS ICD, 4/C, 31.10.2001
 + IRNs:

 COL–RIBRE–IRN–CGS–8134 Issue 1/–  Extended GROUND_CMD_TO_OB_LIB

3.7 Testreport

COL–RIBRE–RP–0457   CGS Regression Testreport for CGS V4.5.1,
      Issue 1/A, 18.04.2002
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4 Installation of the CGS Delivery

4.1   Installation

The installation is to be performed for a Service Release installation.

4.1.1 Install CGS Service Release V4.5.1 by executing the following instructions:

1. Prepare Installation:
– Ensure all CGS software is shutdown and no user are logged in
– Passwords needed:

cgsadmin password
Oracle MDB account password (if default MPS is not used)

2. login as cgsadmin

3. insert the CGS delivery CD–ROM, the CD is mounted by the volume daemon to the directory /cdrom

4. Stop CGS by selecting ”CGS System Shutdown” from the CGS Task Selector

5. setenv DISPLAY <host>:0       –– if not locally logged in

6. cd /cdrom/cdrom0/CGS_4.5.1SR

7. install_cgs_patch

8. enter all requested inputs

The current GSAF_HOME directory is ”Your_GSAF_HOME”. 

Is this correct (y/n) [y] ? y

          Install CGS Patch
          –––––––––––––––––

  Please check the whole directory path of the patch location
  The generic name is /cdrom/CDROMname/ptNumber

Enter patch location [/cdrom/cdrom0/CGS_4.5.1SR]: <your_answer>

Preparing installation of patch CGS_4.5.1

Do you want to save your previous files (yes|no)?[no]: <your_answer>

    If <your_answer> = yes then

  Please enter the directory for the backup file.

Enter directory [/cgs/gsaf/PatchedFiles]: <your_answer>

  Compression of the backup tar file saves space on disk.
  But during compression a temporary amount of space is needed.
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Do you want to compress your saved files (yes|no) ? [no] : yes

  Saving previous files in ”/cgs_user/cgsadmin/CGS_4.5.1.tar”...done.

  Compress backup file as ”/cgs_user/cgsadmin/CGS_4.5.1.tar.Z”...done.

Installing Patch CGS_4.5.1 to GSAF_HOME ...

  Copy files... /
  Base installation was successful.

  *****************************************************************

Executing /cdrom/cgs/CGS_4.5.1/postinstall_patch_CGS_4.5.1

Performing post–installation activities for dbs

... trace of post–installation for DBS

Performing post–installation activities for mda

   Enter system password:

   Enter OWNER NAME of the Oracle MDB account [MPS] <your owner>

   Enter OWNER PASSWORD of the Oracle MDB account [MPS] <your password>

... trace of post–installation for MDA

  New version of <CSS,FWDU,GWDU,HCI,SWES,TEV,TSCV,TSS> is now registered.

  *****************************************************************
  Patch CGS_4.5.1 installation finished. 
  Please check postinstallation output for errors.
  *****************************************************************

4.1.2 Install CSS Product by executing the following instructions:

The CSS product –if needed – requires specific installation via the install_css script (as CGS administrator user):

1. login as cgsadmin

2. cd $CSS_HOME/util/common

3. install_css

CSS Installation

–––––––––––––––

–– Preinstallation/Installation/Deinstallation product css of version 4.5

Change access rights of files ...

Copy predefined configuration file to CSS config directory ...
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This script will increase now on machine <your host> the CPU usage ...

changing <gsaf_home>/css/user–env/cshrc

Now you can work again ...

Installation of Ada Library for sun5

CSS installation succeeded

4.1.3 Remove CD–ROM

4. cd

5. eject

6. logout

4.1.4 Update MDB (for more than one MDB only)

If you have installed more than one MDB, you need to perform an upgrade for each of them. Call for all other
MDBs:

$MDA_HOME/config/mdb/upgrade/upgrade_from_CGS_MDB_Vx_to_CGS_MDB_V4_5_0.sql
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5 Post Installation Steps

5.1  MDB Updates

Refer to CGS Installation Manual.

5.2  Install New UCL Libraries / Recompile APs

5.2.1  UCL System Libraries

The GROUND_TO_OB_LIB  has been updated in this delivery (refer to COL–RIBRE–
IRN–8134). The source code of the library is delivered as UNIX file under $CGS_HOME/config.
It has to be replaced in the MDB at all locations, where the onboard library exists. Subsequent com-
pilation of all libraries/APs referencing the library is needed.

The following operations are new for CGS 4.5.1 

• BUILD_SW_COMMAND

• ABORT_SW_COMMAND

 Library Replacement

 The source code for the new  version of the libraries must be installed in the database (MDB) and replace
any old version of the  Library. 

As the Library may exist in different locations in your database, it is necessary to search for all locations and
replace it everywhere within the MDB. To achieve this, perform the following steps:

1. Start I_MDB Navigator (“Test Preparation” in CGS Task Selector).

2. For each element configuration the following steps shall be done:

3. For each system tree version the following steps shall be repeated as well:

4. In those cases where the  Library is part of a frozen CDU, you will have to create a new CDU version
first (otherwise the library would be read–only and thus could not be updated). Remember to specify
the latest old version of the CDU in the “Copy from CDU Version” field of the “Create new CDU ver-
sion” window.

5. In those cases where the library has not been frozen, simply replace the old source code by the new,
as described below.

6. Navigate to the library end item.   You may want to use the File→Direct End Item Access search facil-
ity of I_MDB to locate all libraries within a CDU automatically: Simply type UCL_SYSTEM_LI-
BRARY into the “End Item Type” field of the “Direct End Item Access” window and click on Search
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& Edit. The Items list in the lower half of the window then displays all UCL System Libraries in the
currently open CDU.

7. Start the CLS Editor by using the “UCL Compiler & Editor...” menu point from the pop–up menu that
is displayed after pressing the right mouse button on the library end item.

8. In the CLS Editor, delete the old source code: Click four times (fast) on the source code window pane.
 This should select the whole source code. (Alternatively: Select first part of source code, scroll to end
of the source code and select all with right mouse button). Then press the Cut key or use Edit→Cut
from the editor’s pop–up menu.

9. Insert the new source code via File→Include File... pop–up menu point: In the “Text:Include” window
enter:

Directory: $GSAF_HOME/cgs/config
     File: ground_to_ob_lib_.ucl

10. Now click on the “Include File” button. The new source code is then loaded into the CLS Editor. Then
click on Command→Compile button.

11. N/A: For UCL User Library, switch to ’body’ and perform step 9 and 10 for the file

Directory: $GSAF_HOME/cgs/config
 File: N/A

12. After the compilation of the library is finished, click on the Command→Store button of the CLS Editor

13. Quit the CLS Editor.

14. In those cases where the  library was part of a frozen CDU: All your CCUs that reference the old CDU
need to be changed as well: They should now reference the newly created CDU instead of referencing
the old obsolete one. Replace these references now using I_MDB. If the CCUs are frozen, you have
to create new CCU versions first.

15. Re–compile all your APs that reference the new system libraries. If your APs are part of a frozen CDU,
you will have to copy them into a new CDU version in advance. Otherwise you will not be able to store
your recompiled code into the database.

16. Repeat the above steps for all system tree versions.

17. Repeat the above steps for all element configurations.

18. Exit I_MDB.

19. Logout.

Recompilation
–––––––––––––––––––––––

All APs and Libraries refering to the a.m. updated libraries need to be recompiled.

5.3  Adaptation of Configuration Files

CGS_4.5.1 allows to enable/suppres error messages for ADU Suspension. The follwing configuration parameters may
be set (additionally) in the $TES_HOME/config/TES_CONFIG_FILE:

!!
!! (E) Enable/disable the message generation in case of ADU suspend
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!!     to message handler log. Independ of this settings all messages
!!     will be logged to TRDB.
!!     Range: true/false
!!     Recommended value: true
DATA_PROCESSOR.SHOW_ADU_SUSPEND_MESSAGE                4       true
!!
!! (E) Enable/disable the message generation in case of ADU resumed
!!     to message handler log. Independ of this settings all messages
!!     will be logged to TRDB.
!!     Range: true/false
!!     Recommended value: false
DATA_PROCESSOR.SHOW_ADU_RESUME_MESSAGE                 4       false

5.4 Generate SCOE Files

To activate changes in the generation of SCOE files recreate the SCOE files of all CCU with the MDB. Therefore per-
form following steps:

1. Start I_MDB Navigator (“Test Preparation” in CGS Task Selector).

2. For each element configuration the following steps shall be done:

3. For each system tree version the following steps shall be repeated as well:

4. select the CCU version and navigate to each enditem of type EGSE_TEST_CONFIGURATION.
To simplify this work use the ”File”–>“Direct End Item Access” window, enter the enditem type
EGSE_TEST_CONFIGURATION and press the ”Search&Edit” button. All enditem within this CCU
of the given type will be listed in the lower part of the window.

5. select the enditems which are used to start the test configuration one by one and select from the pull
down menu (with right mouse button) ”Tools”–>”Generate Scoe Files...”. The ”LoadSCOE” progress
window will apear. Wait until the generation is finished, than press the ”Close” button.

6. Repeat the above steps, beginning with step 3 for all system tree versions.

7. Repeat the above steps, beginning with step 2 for all element configurations.

8. Exit I_MDB.

5.5 Recompile SAS

The CGS_API has been modified internally. Especially the underlying Communication Software has been
modified. To ensure correct working of the SAS using the CGS_API, all SAS using the TES_API are required
to be recompiled using the CGS_API delivered with this patch. Refer to CGS Installation Manual.

After installation, the CGS_API library for Sun needs to be recompiled. For installation and  recompilation procedure
refer to CGS Installation Manual, Issue 4/F, ch. 7. Afterwards, the SAS can be recompiled.
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6 CGS 4.5.0 to CGS 4.5.1  Compatibility Issues

The following is a description of CGS 4.5.0 to CGS 4.5.1 compatibility and functional extensions imple-
mented in CGS_4.5.1

6.1 New Features in CGS 4.5.1

• Updated Commercial Baseline

• MDB Data Structures

• MDB Interactive Interface / MDA Functions

–  BDE Output File Creation: Allow for selection of enditem types / aggregates (SPR–9754)

–  Consistency Checker Corrections/ Performance Improvements

–   (*) ”XML Report Generation” Tool provided as Utility for CGS
  (User definable and printable reports on MDB Contents)

–    FWDU Batch / Upgrade Mode
  (Call FWDU for all fligt=ht synoptics to re–align with changes made to referenced data)

–    GWDU Batch Mode
  (Call GWDU for all synoptics to re–align with changes made to referenced data)

–  CU Based Upgrade of MDB Data: Allow for single CDU/CCU to be upgraded to a new CGS
version

– New CU Version Manager to allow for easy generation of new CDU/CCU versions and for
copy of CDU/CCU versions.

• TRDB Improvements

– Ask for Label on Final Archive Media

• Stimuli, TC, SW Commanding

– New commands BUILD_SW_COMMAND and ABORT_SW_COMMAND

• User Interface Updates

– Synoptic Displays inherit default test nodes from HLCL windows

• Monitoring / Calibration / Data Processing

– Additional message when resuming suspended ADUs (configurable)

• HLCL/UCL/CPL Language Support

– Local Variables allowed in HLCL Sequences

– New data types BYTE, LONG_WORD, BYTE_STRING in UCL/HLCL

– Note: Implementation is completed: Full functionality  in this service release

– New NULL–Statecode in UCL/HLCL (”$$”)

– Note: Implementation is completed: Full functionality in this service release

– New low level conversion in UCL/HLCL (”UNTYPED”)
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– Note: Implementation is completed: Full functionality in this service release

– Allow imports and declarations in advance to AP declarations

– Note: Implementation is completed: Full functionality in this service release

• Software Development Support

–  SWES Load Interface extended to load PDB Label concatenated with SWOP Excecutable
Name and Checksum  (SPR–9978)

• Test Evaluation

• Simulation Model Execution (CSS)

– Signal Running/Stopped Status to CMAS also in realtime mode

• External Interface

– TES_API: Bug fixes in the underlying network software (SPR–9829)

• Major Bug Fixes

– The bug fixes implemented in CGS_4.4.1 to overcome problems in the cummunication softwa-
re during Metop testing at ESTEC have been included, except for  the workaround to store
specific messages in a log file on the testnode (instead of sending them to the message handler).

• Removal/Extension of Restrictions

Note:     (*) Software is available on a separate “ADD–ON SOFTWARE” CD

6.2 Old Features No Longer Available

6.3 Incompatibilities with CGS 4.5.0  Data

6.3.1 MDB Structures

From 4.5.0, no change has been made in the MDB structures. Some SQL procedures stored in the MDB have changed.
This is covered by the installation of the 4.5.1 version.

Note: For upgrading from previous MDB versions specific scripts are provided in $MDA_HOME/config/mdb/upgrade.

6.3.2 TRDB Structures

There is no change in the TRDB structures in this version.
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Appendix A: List of PDB Issues
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Change–Issues implemented in this release.

Status         Author      CHANGE–ID      DATE   SYNOPSIS
–––.P–.I–.––.–– danne CGS–ENH–149 02/03/25 CGS_4.5.1SR Installation Scripts and Data.
–––.P–.I–.––.–– volker CSS–SPR–8005 02/03/15 Monitoring tables etc. lost with each delivery of SIMM
–––.P–.I–.––.–– ilenz MDA–SPR–10768 02/03/15 CC CGS–55 takes too long
–––.P–.I–.––.–– franz CLS–SPR–11379 02/03/15 INDEX_ERROR when compiling library body
–––.P–.I–.––.–– werner TES–ENH–514 02/03/14 Fixed bug in RELEASE_WAIT_EVENT
–––.P–.I–.––.–– ilenz MDA–ENH–4529 02/03/14 Performance optimization of CGS–ERR–005
–––.P–.I–.––.–– marz TES–ENH–512 02/03/14 correct TES_CONFIG_FILE
–––.P–.I–.––.–– franz CLS–SPR–11325.1 02/03/11 CLS_Editor Compiler found cyclic reference in up to now perfect AP
–––.P–.I–.––.–– danne HCI–ADP–5 02/03/08 HCI–ENH–350
–––.P–.I–.––.–– franz CLS–SPR–11325 02/03/08 CLS_Editor Compiler found cyclic reference in up to now perfect AP
–––.P–.I–.––.–– franz CLS–SPR–11300 02/03/07 UCL: Wrong code for UNTYPED (parameterized pathname)
–––.P–.I–.––.–– werner CSS–SPR–11295 02/03/07 Extend CSS functionality implemented for SPR 9675
–––.P–.I–.––.–– athmann CGS–IRN–8134 02/03/06 New Commands in GRN_CMD_TO_OB_LIB
–––.P–.I–.––.–– franz !CLS–ENH–395 02/03/05 Tools update
–––.P–.I–.––.–– werner !TES–IRN–8134 02/03/04 UCL Ground Cmd to OB Updates
–––.P–.I–.––.–– franz CLS–SPR–11298 02/03/01 CLS Editor: Bad error message if identifier is not imported
–––.P–.I–.––.–– franz CLS–SPR–11028.1 02/03/01 CLS Editor: IMPORT fails when using alias
–––.P–.I–.––.–– franz CLS–SPR–11028 02/03/01 CLS Editor: IMPORT fails when using alias
–––.P–.I–.––.–– franz CLS–SPR–11081 02/02/27 Recursive parameterized pathnames not allowed in UCL
–––.P–.I–.––.–– ilenz MDA–SPR–11259 02/02/27 ExcelMDB Tool Read Failure
–––.P–.I–.––.–– bier MDA–SPR–11276 02/02/27 bde pathname syntax check does not work
–––.P–.I–.––.–– ilenz MDA–SPR–11272 02/02/26 install_mdb: grant select any table is missing for MDB owner
–––.P–.I–.––.–– marz TES–SPR–10824 02/02/26 Resume message for Suspend–ADU message missing
–––.P–.I–.––.–– jstammi MDA–SPR–11263 02/02/26 I_MDB import does not find import file in home directory
–––.P–.I–.––.–– franz CLS–SPR–10624 02/02/22 Wrong i–code generation for UCL case statement
–––.P–.I–.––.–– franz CGSI–ENH–600 02/02/22 Spec enhancement of SORT_MERGE
–––.P–.I–.––.–– ilenz MDA–SPR–10791.1 02/02/21 Files created trough create BDE Files cannot be imported via BDE !
–––.P–.I–.––.–– bier MDA–SPR–11244.1 02/02/21 CU Version Manager: error clicking background of browser
–––.P–.I–.––.–– ilenz MDA–SPR–11236.1 02/02/20 BDE failure: aggregate T_PATHNAME_CONSTRAINTS and
T_WDU_GR_STATE_CODE_LISTS
–––.P–.I–.––.–– grotheer MDA–SPR–9667.1 02/02/19 MDB Check C22 failure (Max Alarm Counter)
–––.P–.I–.––.–– mata CLS–ENH–394 02/02/15 tool update
–––.P–.I–.––.–– ilenz MDA–SPR–11176.1 02/02/12 Recreate CLS  files (i–code–generation) failure: AP–Parameter parameterized
pathname
–––.P–.I–.––.–– franz CLS–ENH–391 02/02/08 TOOL_SUPPORT: don’t support pathnames /.../.../...
–––.P–.I–.––.–– franz CGSI–ENH–595 02/02/08 Byte/Char. string conversions moved from Byte_String_Lib to Support_Li-
brary
–––.P–.I–.––.–– volker GWDU–SPR–9388.1 02/02/08 Missing batch compile function for ground synoptic displays
–––.P–.I–.––.–– bier MDA–SPR–11149 02/02/08 BDE cannot load NULL enumeration values
–––.P–.I–.––.–– franz CLS–ENH–390 02/02/07 Tools update
–––.P–.I–.––.–– mata CLS–ENH–387 02/02/07 tool update
–––.P–.I–.––.–– volker GWDU–SPR–11031 02/02/04 GWDU background colour
–––.P–.I–.––.–– bier MDA–ENH–4528.1 02/02/01 DADIMA v5.2
–––.P–.I–.––.–– ilenz MDA–SPR–11093 02/01/31 CLS Editor/Compiler unable to work with references outside Owner CDU
–––.P–.I–.––.–– bier MDA–ENH–4528 02/01/31 DADIMA v5.2
–––.P–.I–.––.–– dcarl FWDU–ENH–50 02/01/29 CGS patch CGS_4.5.0P14: FWDU upgrade tool
–––.P–.I–.––.–– bier MDA–SPR–11082 02/01/29 CU version manager cannot handle identical item references
–––.P–.I–.––.–– ilenz MDA–ENH–4527 02/01/28 Performance optimization of CC_SETUP.REMOVE_CHECK
–––.P–.I–.––.–– mata CLS–ENH–381 02/01/24 tools update
–––.P–.I–.––.–– ilenz MDA–SPR–10711.2 02/01/21 CC CGS–005 takes too long
–––.P–.I–.––.–– franz CLS–ENH–377 02/01/17 Added UCL/HLCL/CPL Reference Manuals
–––.P–.I–.––.–– jstammi MDA–SPR–10978.1 02/01/17 MDBD 6.1.1 on Int1dbs (SIVQ Test Site 1) corrupted 
–––.P–.I–.––.–– jstammi MDA–SPR–10978 02/01/17 MDBD 6.1.1 on Int1dbs (SIVQ Test Site 1) corrupted 
–––.P–.I–.––.–– jstammi MDA–SPR–11024.1 02/01/17 Export problem with splitting paramfile
–––.P–.I–.––.–– jstammi MDA–SPR–11024 02/01/17 Export problem with splitting paramfile
–––.P–.I–.––.–– svogel CLS–ENH–374 02/01/17 interpreter
–––.P–.I–.––.–– franz CGSI–ENH–590 02/01/16 Correction
–––.P–.I–.––.–– franz CLS–ENH–372 02/01/15 Some corrections and enhancements
–––.P–.I–.––.–– ilenz MDA–SPR–10802.1 02/01/14 BDE CEI aborts with end item descriptions of 80 chars length
–––.P–.I–.––.–– franz CLS–SPR–10989 02/01/14 Internal Error When Setting HLCL Flags
–––.P–.I–.––.–– marz TES–SPR–10980 02/01/10 Wrong return status for procedure INIT_APPLICATION
–––.P–.I–.––.–– franz CLS–ENH–366 02/01/10 Correction of DB –> UCL type conversion for parameterized types
–––.P–.I–.––.–– ilenz MDA–SPR–10498.1 02/01/10 BDE: Virtual Nodes Not Loaded
–––.P–.I–.––.–– franz CLS–ENH–365 02/01/09 Correction
–––.P–.I–.––.–– franz CLS–ENH–363 02/01/09 Two optimizations (time comparison + UPDATE in COMMAND_PANEL)
–––.P–.I–.––.–– ilenz MDA–SPR–10958.2 02/01/09 Difference Report Fails on CCU Comparison (2)
–––.P–.I–.––.–– franz CGSI–ENH–586 02/01/07 New UCL user library Byte_String_Lib
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–––.P–.I–.––.–– marz TES–SPR–9932 02/01/07 Failed to setup test node in simulation mode
–––.P–.I–.––.–– bier MDA–SPR–10961 02/01/07 Difference Report Fails on CCU Comparison (2)
–––.P–.I–.––.–– ilenz MDA–ENH–5198.1 01/12/21 delete_invalid_data: fixed problem in del_invalid_foreign_key_aggregates.sql
–––.P–.I–.––.–– ilenz MDA–ENH–4526 01/12/20 install_mdb: MDA_PROCS and BDE added
–––.P–.I–.––.–– ilenz MDA–ENH–4525 01/12/20 cp_mda_mdb (preinstall_mda): BDE and MDA_PROCS added
–––.P–.I–.––.–– ilenz MDA–ENH–4524 01/12/20 $MDA_HOME/oracle_env/get_system_password added
–––.P–.I–.––.–– froese MDA–SPR–10948.1 01/12/19 I_MDB: create (copy from) system tree version fails
–––.P–.I–.––.–– ilenz MDA–ENH–4523 01/12/19 preinstall_mda corrected
–––.P–.I–.––.–– froese MDA–ENH–5185.1 01/12/19 IMDB: Tool invocation for System Tree Version
–––.P–.I–.––.–– bier MDA–ENH–4522 01/12/19 CUVM: fixed propblem with scope > 100 CDUs
–––.P–.I–.––.–– ilenz MDA–ENH–4521.1 01/12/18 DADIMA: cp_mda_dadi: load_cgs_standard_agg added
–––.P–.I–.––.–– ilenz MDA–ENH–4521 01/12/18 DADIMA: load_cgs_standard_agg added
–––.P–.I–.––.–– franz CLS–ENH–361.1 01/12/18 Comment for last change added.
–––.P–.I–.––.–– franz CLS–ENH–361 01/12/18 Reference handling corrected, update handling optimized
–––.P–.I–.––.–– franz CLS–ENH–360 01/12/17 Correction to parameter decoding
–––.P–.I–.––.–– pesch CGSI–SPR–9926 01/12/14 Inappropriate ioctl for device
–––.P–.I–.––.–– franz CLS–ENH–359 01/12/13 MDB emulation update: rudimentary nickname support
–––.P–.I–.––.–– ilenz MDA–SPR–10710 01/12/12 CC CGS–77/78 take too long
–––.P–.I–.––.–– ilenz MDA–ENH–4520 01/12/11 bde: fixed target_dependencies2 file
–––.P–.I–.––.–– svogel CLS–ENH–355 01/12/11 interpreter
–––.P–.I–.––.–– franz CLS–SPR–10262 01/12/10 CLS: Batch Compile Misses Out Of Date Items
–––.P–.I–.––.–– franz CLS–ENH–354 01/12/10 MDB emulation update
–––.P–.I–.––.–– athmann MDA–ENH–9846 01/12/06 Check–MDB–Item V4.5.01: SPR–10279 and Reference / Print extensions
–––.P–.I–.––.–– pdbcgs CGS–ENH–119 01/12/05 PDB: new source container mda/cu_version_manager
–––.P–.I–.––.–– werner DBS–ENH–128 01/12/04 Error when creating already existing session
–––.P–.I–.––.–– bier MDA–ENH–4519 01/12/04 CU Version Manager
–––.P–.I–.––.–– franz CGSI–ENH–577 01/12/03 New Time_Library and library correction
–––.P–.I–.––.–– franz CLS–SPR–10880 01/12/03 Conversion (String of Byte) Failure
–––.P–.I–.––.–– ilenz MDA–SPR–10855 01/11/29 CC aborts during CGS–ERR–005 checks
–––.P–.I–.––.–– bier MDA–SPR–10849 01/11/27 BDE does not check for consecutive entry numbers
–––.P–.I–.––.–– adt_3 !TSCV–SPR–10823 01/11/27 CSS not participating
–––.P–.I–.––.–– bier MDA–SPR–10322 01/11/27 BDE–CU: Unable to create scope
–––.P–.I–.––.–– bier MDA–SPR–10819 01/11/26 Pathname Support kills GWDU
–––.P–.I–.––.–– volker GWDU–SPR–10819 01/11/23 Pathname Support kills GWDU
–––.P–.I–.––.–– ilenz MDA–ENH–4518 01/11/23 Change cp_mda_dadi
–––.P–.I–.––.–– ilenz MDA–ENH–4517 01/11/23 DADI–MA: version 5.1
–––.P–.I–.––.–– ilenz MDA–ENH–4516 01/11/22 DADI–MA: Add Attribute default and alias
–––.P–.I–.––.–– franz CLS–SPR–9242 01/11/22 Missing data information
–––.P–.I–.––.–– athmann CGS–SPR–10426 01/11/21 missing CGS ICD for CGS 4.5
–––.P–.I–.––.–– franz CLS–SPR–10603.2 01/11/20 No support of local variables, aliases etc in HLCL
–––.P–.I–.––.–– ilenz MDA–ENH–4515 01/11/20 CC: Add CC_PROGRESS and CC_DEBUG
–––.P–.I–.––.–– volker GWDU–SPR–10596.101/11/16 Multiplied number of end items in ground synoptic displays
–––.P–.I–.––.–– franz CLS–SPR–10603 01/11/16 No support of local variables, aliases etc in HLCL
–––.P–.I–.––.–– volker GWDU–SPR–10596 01/11/16 Multiplied number of end items in ground synoptic displays
–––.P–.I–.––.–– ilenz MDA–SPR–10342.2 01/11/15 DDED crashes with oracle error
–––.P–.I–.––.–– froese MDA–SPR–10491.1 01/11/14 I_MDB: Badly formed error message
–––.P–.I–.––.–– froese MDA–SPR–10342.1 01/11/14 DDED crashes with oracle error
–––.P–.I–.––.–– dcarl FWDU–ENH–49 01/11/14 FWDU 3.2.8 for CGS 4.5.0P11
–––.P–.I–.––.–– bier MDA–ENH–4514 01/11/14 common MDA tcl and PL/SQL functions
–––.P–.I–.––.–– svogel CLS–ENH–353 01/11/12 new dialog procedures
–––.P–.I–.––.–– franz CLS–SPR–5422 01/11/11 array of WORD parameters treated incorrectly
–––.P–.I–.––.–– ilenz MDA–ENH–4513 01/11/06 CC: performance optimization 1
–––.P–.I–.––.–– danne HCI–SPR–9524 01/11/05 HCI: Synoptic display does not inherit default testnode from HLCL command
window
–––.P–.I–.––.–– grotheer SWES–SPR–9978 01/11/02 trace back of SWRU End Items not possible 
–––.P–.I–.––.–– ilenz MDA–SPR–10681 01/11/01 CLS batch compilation (forced) as CMUSER does not work
–––.P–.I–.––.–– jstammi MDA–ENH–9841.6 01/10/31 P10: CU based upgrade
–––.P–.I–.––.–– jstammi MDA–ENH–9841.5 01/10/31 P10: CU based upgrade
–––.P–.I–.––.–– jstammi MDA–ENH–9841.4 01/10/31 P10: CU based upgrade
–––.P–.I–.––.–– jstammi MDA–ENH–9841.3 01/10/31 P10: CU based upgrade
–––.P–.I–.––.–– froese MDA–ENH–9841.2 01/10/30 P10: Cu based upgrade
–––.P–.I–.––.–– jstammi MDA–ENH–9841.1 01/10/30 P10: CU based upgrade
–––.P–.I–.––.–– jstammi MDA–ENH–9841 01/10/30 P10: CU based upgrade
–––.P–.I–.––.–– werner DBS–SPR–9866.2 01/10/29 Gap in TRDB event log (MetOp NCR 165)
–––.P–.I–.––.–– ilenz MDA–SPR–10316 01/10/26 install_mdb.exec: ”unalias” Used Incorrectly
–––.P–.I–.––.–– werner DBS–SPR–9866.1 01/10/25 Gap in TRDB event log (MetOp NCR 165)
–––.P–.I–.––.–– franz CLS–SPR–10554.2 01/10/24 CLS/HLCL: Optional Semicolon Not Always Allowed
–––.P–.I–.––.–– franz CLS–SPR–10625 01/10/18 UCL Compiler Reports Constraint_Error for Invalid Statecode
–––.P–.I–.––.–– froese MDA–SPR–10496.2 01/10/16 Consistency Date on CCUs mis–used / makes BATCH CC processing impossi-
ble
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–––.P–.I–.––.–– franz CLS–SPR–10548 01/10/15 Invalid Type Conversion
–––.P–.I–.––.–– franz CLS–SPR–10554 01/10/15 CLS/HLCL: Optional Semicolon Not Always Allowed
–––.P–.I–.––.–– bade TSS–ENH–43.1 01/10/15 Fixed bug in start_tss_tsp
–––.P–.I–.––.–– ilenz MDA–SPR–10496 01/10/15 Consistency Date on CCUs mis–used / makes BATCH CC processing impossi-
ble
–––.P–.I–.––.–– froese MDA–SPR–10592 01/10/12 Wrong used check categories data in CC result file
–––.P–.I–.––.–– ilenz MDA–SPR–10543 01/10/11 Checks CGS–ERR–10/–77 lead to abort of Consistency Checker
–––.P–.I–.––.–– svogel CLS–ENH–352 01/10/02 onboard lib
–––.P–.I–.––.–– svogel CLS–ENH–351 01/10/02 hlcl window
–––.P–.I–.––.–– froese MDA–SPR–10500.1 01/09/27 I_MDB: Crash (STORAGE_ERROR) when trying to change ownership of
CCU
–––.P–.I–.––.–– franz CLS–SPR–10021 01/09/24 CLS Dependency Handler reports end item to be out of date, but it isn’t
–––.P–.I–.––.–– edvin CLS–ENH–349 01/09/24 Tools update
–––.P–.I–.––.–– franz CLS–SPR–10477 01/09/21 internal error: Exception TYPE_ERROR
–––.P–.I–.––.–– bade !NWSW–ENH–48 01/09/21 Just a TES simulator
–––.P–.I–.––.–– ilenz MDA–SPR–10437 01/09/21 CLS batch compile/make tool is unable to store
–––.P–.I–.––.–– franz CLS–ENH–347 01/09/20 MDB emulation update
–––.P–.I–.––.–– franz CLS–SPR–8927.16 01/09/20 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– froese MDA–SPR–10147.2 01/09/20 New CC crashes when pressing the right mouse button
–––.P–.I–.––.–– edvin CLS–ENH–345 01/09/19 Tools update
–––.P–.I–.––.–– volker GWDU–SPR–7455.3 01/09/18 After BDE export/import synoptics do not work 
–––.P–.I–.––.–– froese MDA–SPR–10147 01/09/18 New CC crashes when pressing the right mouse button
–––.P–.I–.––.–– froese MDA–SPR–10349 01/09/17 CC does not select the selected enditem
–––.P–.I–.––.–– ilenz MDA–SPR–10403 01/09/17 MDA Data API Procedure Convert_CDU behaviour ambiguous
–––.P–.I–.––.–– franz CLS–SPR–8927.14 01/09/14 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– ilenz MDA–ENH–4512 01/09/14 together with MDA–ENH–4511
–––.P–.I–.––.–– ilenz MDA–SPR–9862.1 01/09/14 I_MDB: Copy/Move should reset compilation status for CLS end items
–––.P–.I–.––.–– franz CLS–SPR–10411 01/09/13 CLS: UCL compiler does not accept DURATION as function return type
–––.P–.I–.––.–– franz CLS–SPR–8927.12 01/09/13 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– franz !CLS–ENH–342 01/09/12 Tools update for various language extensions
–––.P–.I–.––.–– franz CLS–SPR–8927.10 01/09/12 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– danne HCI–ADP–4 01/09/12 CGSI–SPR–10282
–––.P–.I–.––.–– franz CLS–SPR–8927.8 01/09/12 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– dcarl FWDU–ENH–48 01/09/11 FWDU 3.2.7 for CGS 4.5 QP06
–––.P–.I–.––.–– franz CLS–ENH–340 01/09/11 Tools update for various language extensions
–––.P–.I–.––.–– franz CLS–SPR–8927.6 01/09/11 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– edvin CLS–ENH–338 01/09/10 Check tool
–––.P–.I–.––.–– franz CLS–SPR–8927.5 01/09/09 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– franz CLS–SPR–8927.4 01/09/07 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– franz CLS–SPR–8927.3 01/09/07 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– franz CLS–SPR–10346 01/09/07 HLCL: Internal error in CHECK
–––.P–.I–.––.–– franz CLS–SPR–8927.2 01/09/05 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– franz CLS–SPR–5891.2 01/09/04 Constrained pathname types as FLAP and LIB–routine para
–––.P–.I–.––.–– franz CLS–SPR–5891.1 01/09/03 Constrained pathname types as FLAP and LIB–routine para
–––.P–.I–.––.–– franz CLS–SPR–5891 01/09/03 Constrained pathname types as FLAP and LIB–routine para
–––.P–.I–.––.–– franz CLS–SPR–8927.1 01/09/03 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– ilenz MDA–ENH–4511 01/09/03 performance optimization of table PATHNAME_SID_REL
–––.P–.I–.––.–– volker GWDU–SPR–7455.2 01/08/31 After BDE export/import synoptics do not work 
–––.P–.I–.––.–– froese MDA–SPR–10323 01/08/31 New CC: Chosen item types erroneously evaluated from profile
–––.P–.I–.––.–– froese MDA–SPR–10326 01/08/31 I_MDB crash when deleting used CCU version
–––.P–.I–.––.–– ilenz MDA–SPR–7435 01/08/31 CGS/HLCL: Returned statecode type not complete
–––.P–.I–.––.–– froese MDA–SPR–8872.4 01/08/30 DDED: API_SET_STATUS_ERROR
–––.P–.I–.––.–– froese MDA–SPR–9507.5 01/08/29 I–MDB does not allow data maintenace
–––.P–.I–.––.–– grotheer MDA–ENH–9837 01/08/29 ADT_TEST_CONFIGURATION limits
–––.P–.I–.––.–– franz CLS–SPR–8927 01/08/28 UCL extension: ’string of BYTE’
–––.P–.I–.––.–– ilenz MDA–SPR–9754.3 01/08/28 BDE out data file generation
–––.P–.I–.––.–– athmann CGS–ENH–103 01/08/27 New Version of Add–On_Tools (IDE,Reports)
–––.P–.I–.––.–– ilenz MDA–SPR–9150 01/08/27 Derived Parameter: incorrect i–code after I_MDB copy–paste
–––.P–.I–.––.–– bade TSS–ENH–44 01/08/27 Bug fixed in asynchronous SMT notification function
–––.P–.I–.––.–– bier MDA–SPR–9754.1 01/08/27 BDE out data file generation
–––.P–.I–.––.–– froese MDA–SPR–10108 01/08/27 New CC: no report file without output on screen possible
–––.P–.I–.––.–– bier MDA–SPR–9754 01/08/27 BDE out data file generation
–––.P–.I–.––.–– volker GWDU–SPR–7455.1 01/08/24 After BDE export/import synoptics do not work 
–––.P–.I–.––.–– bade TSS–ENH–43 01/08/24 PID–file for TSP added
–––.P–.I–.––.–– ilenz MDA–SPR–10251 01/08/24 MDA: Unable to Retrieve MAX(LONG_REAL)
–––.P–.I–.––.–– froese MDA–SPR–9507 01/08/23 I–MDB does not allow data maintenace
–––.P–.I–.––.–– ilenz MDA–SPR–9507.1 01/08/23 I–MDB does not allow data maintenace
–––.P–.I–.––.–– ilenz MDA–ENH–4380 01/08/20 new DADIMA
–––.P–.I–.––.–– volker GWDU–SPR–7455 01/08/16 After BDE export/import synoptics do not work 
–––.P–.I–.––.–– franz CLS–SPR–9024 01/08/16 UCL extension: statecode null value ($$)
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–––.P–.I–.––.–– edvin CLS–ENH–323 01/08/16 Impementation for derived values
–––.P–.I–.––.–– werner CSS–ENH–121 01/08/14 Invalid CSS versionfile
–––.P–.I–.––.–– ilenz MDA–SPR–8311 01/08/14 MDB Report: CCU_VERSIONS_REPORT failure
–––.P–.I–.––.–– halwick TEV–SPR–8939.1 01/08/14 TEV: Old User Manual Displayed
–––.P–.I–.T–.–– marz TES–ENH–433 01/08/13 undo previous issue
–––.P–.I–.T–.Q– marz TES–ENH–432
01/08/13 change target_dependencies2 to see correct versions
–––.P–.I–.––.–– halwick TEV–SPR–8939 01/08/10 TEV: Old User Manual Displayed
–––.P–.I–.––.–– ilenz MDA–SPR–9228 01/08/09 MDA: CCU EI XREF REPORT runs for days on APM configurations
–––.P–.I–.––.–– ilenz MDA–SPR–8428 01/08/09 CDU deifference report does not detect changed date/time within one day
–––.P–.I–.––.–– franz CLS–ENH–322 01/08/09 Tools update
–––.P–.I–.––.–– franz CLS–ENH–321 01/08/09 Tools update
–––.P–.I–.––.–– franz CLS–SPR–9418.1 01/08/08 GET_APPLICATION_STATUS causes ”Internal error” in HLCL and AP/TES
to hang
–––.P–.I–.––.–– franz CLS–ENH–319 01/08/08 Tools update
–––.P–.I–.––.–– halwick TEV–SPR–9543 01/08/07 The selected execution session is not selected
–––.P–.I–.––.–– halwick TEV–SPR–8949.2 01/08/07 TEV: Statistics Generation fails when disk is full
–––.P–.I–.––.–– ilenz MDA–SPR–9387 01/08/07 BDE–CEI/I_MDB: End item naming constraints different
–––.P–.I–.––.–– werner DBS–SPR–8991 01/08/07 No error status returned from DBS
–––.P–.I–.––.–– halwick TEV–SPR–8935.2 01/08/07 Waste of disk space
–––.P–.I–.––.–– halwick TEV–SPR–8949.1 01/08/07 TEV: Statistics Generation fails when disk is full
–––.P–.I–.––.–– werner DBS–SPR–9866 01/08/06 Gap in TRDB event log (MetOp NCR 165)
–––.P–.I–.––.–– franz CLS–SPR–10027 01/08/06 CLS installation raises error
–––.P–.I–.––.–– ilenz MDA–SPR–10113 01/08/06 New CC causes delayed working in I–MDB and other input tools
–––.P–.I–.––.–– svogel CLS–ENH–315 01/08/03 onboard library
–––.P–.I–.––.–– svogel CLS–ENH–314 01/08/03 confirm
–––.P–.I–.––.–– werner DBS–SPR–9699 01/07/31 Lot of errors for FA when closing test session
–––.P–.I–.––.–– werner CSS–SPR–10042 01/07/26 Problem in CSS library installation
–––.P–.I–.––.–– grotheer SWES–SPR–8843 01/07/26 C SWEU/SWRU load functions ignore the MDB ownership, consistency and
locking concepts.
–––.P–.I–.––.–– grotheer SWES–SPR–8844 01/07/26 CGS load SWRU/SWEU in batch mode not usable
–––.P–.I–.––.–– werner DBS–SPR–9649 01/07/26 Missing functions for TRDB archive/export tools
–––.P–.I–.––.–– adt_2 !CLS–SPR–9570 01/07/19 FWDU rejects software commands with timestamps
–––.P–.I–.––.–– marz TES–ENH–428 01/07/18 do not print stop_smt_error
–––.P–.I–.––.–– werner DBS–SPR–9847 01/07/18 Manual final archiving of some test sessions not possible
–––.P–.I–.––.–– volker GWDU–SPR–9388 01/07/17 Missing batch compile function for ground synoptic displays
–––.P–.I–.––.–– bade HCI–ENH–288 01/07/17 Fixed bug in vcs_adt_physical_address
–––.P–.I–.––.–– werner DBS–SPR–9671.1 01/07/16 dbs_central_exec : semop: REQUEST: Invalid argument
–––.P–.I–.––.–– ilenz MDA–SPR–9992 01/07/13 New CC: messages not appearing in the texteditor output in the postprocessor
–––.P–.I–.––.–– svogel CLS–ENH–311 01/07/11 mdb iterate
–––.P–.I–.––.–– ilenz MDA–SPR–10004.2 01/07/11 CGS consistency check CGS–ERR–102 does not work correctly
–––.P–.I–.––.–– ilenz MDA–SPR–10004.1 01/07/06 CGS consistency check CGS–ERR–102 does not work correctly
–––.P–.I–.––.–– ilenz MDA–SPR–10004 01/07/06 CGS consistency check CGS–ERR–102 does not work correctly
–––.P–.I–.––.–– adt_3 TSCV–SPR–9993.1 01/07/04 Failed to start the Automated Procedure on MTP
–––.P–.I–.––.–– froese MDA–SPR–9991 01/07/04 New CC: wrong details shown for error message in postprocessor
–––.P–.I–.––.–– froese MDA–SPR–9990 01/07/04 New CC: missing error messages in Post Processor
–––.P–.I–.––.–– svogel CLS–ENH–308 01/07/04 deadlock on onboard_lib
–––.P–.I–.––.–– halwick TEV–SPR–9922 01/07/04 TEV does not display GDU’s
–––.P–.I–.––.–– froese MDA–SPR–9987 01/07/04 I_MDB crash when leaving aggregate window
–––.P–.I–.––.–– svogel CLS–ENH–306 01/07/03 new onboard library
–––.P–.I–.––.–– ilenz MDA–ENH–4382 01/07/02 change of /pdb/cgs/mda/dadi/cp_mda_dadi
–––.P–.I–.––.–– ilenz MDA–ENH–4383 01/06/29 New DADIMA tool
–––.P–.I–.––.–– danne HCI–ENH–286 01/06/29 Documented proxy attributes
–––.P–.I–.T–.–– adt_3 TSCV–SPR–9681 01/06/28 TSCV: Strange Refresh Operation
–––.P–.I–.T–.–– danne HCI–ENH–285 01/06/28 Repaired 4.4 changes of HCI–SPR–9784
–––.P–.I–.T–.–– ilenz MDA–ENH–4384 01/06/28 initialize_mdb: Add execution of user defined initialization procedures
–––.P–.I–.T–.–– ilenz !MDA–ENH–4385 01/06/28 Issue 4/D of MDA User and Operations manual
–––.P–.I–.T–.–– marz TES–ENH–406 01/06/28 undo TES–ENH–405 for 4.5
–––.P–.I–.T–.Q– marz TES–ENH–405
01/06/28 change target_dependencies2
–––.P–.I–.T–.–– marz TES–ENH–403 01/06/27 undo TES–SPR–9840
–––.P–.I–.T–.Q– marz TES–SPR–9840
01/06/27 RPC usage in Error services seems to disturb ADA RTS
–––.P–.I–.T–.–– adt_2 CLS–SPR–9613 01/06/26 CPL scripts: compilation fails for comparisions containing state code values
–––.P–.I–.T–.Q– danne HCI–SPR–9784
01/06/26 OpenWindows blocks update of synoptics
–––.P–.I–.T–.–– athmann !CGS–ENH–91 01/06/25 CGS User Manual 2/M for CGS_4.5.0
–––.P–.I–.T–.–– athmann CGS–ENH–90 01/06/22 Align scripts for CD generation of Add On Tools
–––.P–.I–.T–.–– athmann CGS–ENH–89 01/06/22 New version of IDE/Report Generator (”addontools”) from A.Grunwald
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Appendix B: Open SPRs
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SPR–5554 Select more than 1 session in Test Session Maintenance TSCV 
SPR–5568 HLCL does not support subitems of array types CLS 
SPR–6336 HCI is blocked when sending TC with 255 parameters MDA 
SPR–6544 Consistency checker misses out–of–date references CGS 
SPR–6642 Unexpected end of UCL batch compiler MDA 
SPR–6763 HCI crash MDA 
SPR–6784 Integer Value of Integer Definition of EGSE_PREDEFINED_TC MDA 
SPR–7188 FA_SAS tries to write to an unformatted disc (CALL–820) DBS 
SPR–7376 CGS TSCV – Communication break–down not signaled to the operator TSCV 
SPR–7435 CGS/HLCL: Returned statecode type not complete MDA 
SPR–7730 UCL Interpreter: error in INCL and EXCL instructions CLS 
SPR–7745 TSS not configured after CGS installation TSS 
SPR–7764 Monitoring Colour ’soft limited violated’ when ’Value=low soft limit’ HCI 
SPR–7828 Could not load synoptic (OVERVIEW1). HCI 
SPR–7837 No data maintained by TES_02. HCI 
SPR–7845 NWSW Blocks HCI Process NWSW
SPR–7848 Could not create a CDU under the system tree MDA 
SPR–7853 After DEVICE_ERROR no system recovery possible DBS 
SPR–7913 Unexpected termination of Online Test Control HCI 
SPR–7940 Used Position Number in Bit Stream Layout must be unique MDA 
SPR–7969 EGSE_PREDEFINED_TC: Missing checks for General Bitstream Layout MDA 
SPR–7989 GWDU ignores defined variable range GWDU
SPR–8006 Unexpected Exception in HLCL Command window CLS 
SPR–8031 CLS Batch Compiler doesn’t report UCL Sources in frozen CDUs MDA 
SPR–8102 Execution time of HLCL commands to long CGS 
SPR–8146 CGS does not work after disconnect/connect the TN LAN CGS 
SPR–8215 CSS garbage collection loops CSS 
SPR–8618 GWDU editor / synoptic display HCI 
SPR–8684 Installation of new Load SW IF incomplete SWES 
SPR–8695 CDI editor for init. CDIs not usable MDA 
SPR–8702 BDE: Logfiles deleted in case of errors MDA 
SPR–8888 MDA export.info file incomplete MDA 
SPR–8932 Select on SMT not working in TEV events logging tool CGS 
SPR–8934 FWDU – wrong MCD title line FWDU 
SPR–8982 BDE tool raises undocumented error messages MDA 
SPR–9012 HLCL Command window hangs HCI 
SPR–9018 UCL Automated Proc. MMI Ext. can not be defined MDA 
SPR–9023 Load SCOE fails if no Console is available MDA 
SPR–9028 TEV_SAS not up to date CGS 
SPR–9031 Errors during Load SCOE CGS 
SPR–9042 SCOE file generator produces lot of errors with new MDBD 5.1.0 MDA 
SPR–9051 I_MDB: Changes of the float value format without any reason MDA 
SPR–9091 Installation Manual: Upgrade Procedure, Deinstallation of DADIMA tool CGS 
SPR–9092 Start of test session in TSCV failed due to wrong HP UX configuration CGS 
SPR–9095 Load_Application timeout error CGSI 
SPR–9139 Derived Values: Inconsistent end items MDA 
SPR–9204 P_MDB: MDB_ITEMS.READ_CHILDREN returns a node out of scope MDA 
SPR–9263 HCI blocked during 24 hour test CGSI 
SPR–9296 Not all packet types for commands are allowed MDA 
SPR–9382 GWDU crashes on ULTRA10/Creator3D machine GWDU 
SPR–9404 HCI freezes workstation if HLCL window quit before finished CLS 
SPR–9480 TEV Data Set Generation Problem TEV 
SPR–9490 GWDU: Why is display color of high limit influenced by low limit? GWDU 
SPR–9507 I–MDB does not allow data maintenace MDA
SPR–9570 FWDU rejects software commands with timestamps   CLS
SPR–9638 Testnode 2 disappears during test CGS 
SPR–9646 EGSE end item of type MONITOR_LIST seems to contain errors CGS 
SPR–9653 TES_API improvements TES 
SPR–9707 Differnt behaviour of CLS User Libraries when called from AP or HLCL Command Sequence CLS 
SPR–9733 PLCU could not be booted (no FLAPS on MMI) MDA 
SPR–9755 BDE: storage of composite aggregates not allowed MDA 
SPR–9756 BDE: multirecord not deleted MDA 
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SPR–9765 Create CCU Version Fails MDA 
SPR–9784 OpenWindows blocks update of synoptics HCI 
SPR–9847 Manual final archiving of some test sessions not possible DBS 
SPR–9919 Monitoring not possible when connecting to a running simulation model CSS 
SPR–9925 wrong access permissions for file opcodes_.a CGS 
SPR–9928 Nominal Low Limit monitoring Exception TES 
SPR–9934 CGS daemon not active CGSI 
SPR–9939 time needed for read data from SUN test node greater 1 sec TES 
SPR–9954 Empty confirmation window pops up CGS 
SPR–9970 CPL Parser: Superflous syntax errors reported CLS 
SPR–10026 FWDU not failsafe against Oracle error FWDU 
SPR–10032 Possible damage of data base? CGS 
SPR–10035 Generic PDB version string in motd CGSI 
SPR–10097 No info when install script is aborted CGSI 
SPR–10133 CGS/CLS: HLCL handles imported variables in a wrong way CLS 
SPR–10137 CLS: UCL does not accept \\ for parameterized pathnames CLS 
SPR–10138 Oracle system password missing in inst_a_init_mdb MDA 
SPR–10155 GWDU loose not failsafe against Oracle error GWDU 
SPR–10247 CLS: Error in String Concatenation for Param. Pathname CLS 
SPR–10256 MDA: Cannot Store UCL Items Simultanously MDA 
SPR–10386 CLS Editor Reports Constraint_Error CLS 
SPR–10409 Conversion to string not working in several cases CLS 
SPR–10428 Connect_To_CSS_UI not implemented CGS 
SPR–10496 Consistency Date on CCUs mis–used / makes BATCH CC impossible MDA
SPR–10532 CLS: Problems with unitized types with range constraint CLS 
SPR–10568 Filter of CGS message not working correctly CGSI 
SPR–10592 Wrong used check categories data in CC result file MDA  
SPR–10625 UCL Compiler Reports Constraint_Error for Invalid Statecode CLS  
SPR–10651 Predefined function HIGH works only for open structures CLS 
SPR–10654 Multiple reference of a CDU MDA 
SPR–10700 can not use (special) TC in HLCL – segmentation fault CLS 
SPR–10705 access of CC in batch MDA 
SPR–10709 CC CGS–006 takes too long MDA 
SPR–10785 Unreadable information in Multi Records of MDA MDA 
SPR–10810 BDE cannot handle large number of input files MDA 
SPR–10811 BDE uses not writable temporary directory MDA 
SPR–10821 Foolish errormessage CSS 
SPR–10824 Resume message for Suspend–ADU message missing TES 
SPR–10847 MDB Upgrade Script: Hard–Coded Tablespace MDA 
SPR–10848 bde_load does sometimes not report oracle error MDA 
SPR–10868 Compilable FLAP cannot be stored into the MDB MDA 
SPR–10918 MDB Upgrade: Compressed Export MDA 
SPR–10929 Check Tool missing in CGS 4.5 CLS 
SPR–10937 FWDU upgrade tool not working properly FWDU 
SPR–10986 CGS 4.5.0 P 10 Patch Grants Privileges Incorrectly MDA 
SPR–10987 compile_invalid_sql_objects.sql: Infinite Loop MDA 
SPR–10998 CSS uses 64 kB for long and long raw values CSS 
SPR–11015 CC Output File Selection: Extension?? MDA 
SPR–11053 bde_load/bde_store does not work MDA 
SPR–11259 ExcelMDB Tool Read Failure MDA 
SPR–11263 I_MDB import does not find import file in home directory MDA 
SPR–11272 install_mdb: grant select any table is missing for MDB owner MDA 
SPR–11276 bde pathname syntax check does not work MDA 
SPR–11309 UCL: Wrong code for UNTYPED (scalar) CLS 
SPR–11333 No constraint defined for set_CCSDS_APID CGS 
SPR–11345 FWDU crash after ’Preview’ selection FWDU 
SPR–11373 FWDU Preview – FWDU_SERVER not running FWDU 
SPR–11376 Assignment of minimal integer value not possible in HLCL command window CLS 
SPR–11388 ’I–code for User Library not found’ message in TSCV MDA 
SPR–11397 HLCL Window Hag–Up HCI 
SPR–11400 GWDU Batch Upgrade not selectable MDA 
SPR–11426 GWDU hangs in endless loop GWDU 
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SPR–11428 DDED could not open end items MDA 
SPR–11432 FWDU: Unexpected message window FWDU 
SPR–11441 TES returns an erroneous status after unload_application TES 
SPR–11492 Flex. Reports sort descending does not work MDA 
SPR–11495 SWES: Unexpected exception during loading SRWU in batch SWES 
SPR–11498 SWES: Process waits SWES 
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Appendix C: Workarounds for known Problems
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[1] COL–RIBRE–SPR–6763
MDA: HCI crash 

Description:

Starting an AP from a synoptic button. The AP starts some sub APs. 5 Synoptic pictures will be displayed. At the end
of this scenario HCI crashes. A CORE dump is available( int2dbs: ~cgs2dbs/core.hci_crash).
  
Workaround:

The processes associated with the synoptic continue to work in the background. To start the synoptics go into the CGS
Task Selector and restart the Online Test Control tool. The synoptics will automatically come up in the active state.

[2] COL–RIBRE–SPR–7848
MDA: Could not create a CDU under the system tree 

Description:

As defined in step TP–4.2.1, it is not possible to create a CDU direct under the system tree. 
After the CDU Version Window is opened to create a new CDU version, an error message ”Wrong MDB instance” is
shown in the footer of the
window Create CDU Version. 

Checking the instance with 
select * from t_system_tree_nodes where f_node_name=’EURECA’; 
shows the correct MDB–Instance. 

Navigating down in the system tree shows, that it is possible to create a CDU at any level in the MDB (but not under
the system tree). 

The behaviour could be reproduced, also on SIVQ environment. 
  
Workaround:

From SPA: 

Open the CDU node via double click on the CDU list item.

[3] COL–RIBRE–SPR–8146
CGS: CGS does not work after disconnect/connect the TN LAN 
  
Description:
In testprocedure COL–SEA–QTP–001–ABT issue 6 step 7.5–64 ff failed. 
After disconnect the Lan from the Test Node and reconnect after a time, no 
CGS operations works (e.g. Stop_acquisition ’enditem’). It looks like the 
enditem is not known any more by the system. 

 
  
Workaround:

Call System Advisory Window to restablish connections to the test nodes.
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[4] COL–RIBRE–SPR–9382
GWDU: GWDU crashes on ULTRA10/Creator3D machine 
  
Description:
GWDU started remote (setenv DISPLAY=...) with display on Sun ULTRA10 with Creator 3D graphic adapter. 
The GWDU comes up with the nominal screen layout plus an additional window in the middle of the GWDU window
titled:
”PaletteExposeCB”. Then, three error messages are generated to the console as follows: 
<severe>: Can’t open the file. 
VIfopen: emptyBW.v 
<severe>: Can’t open the file. 
VIfopen: emptyBW.v 

The color palette initially comes up blank, with title line ’Index xxx’. 
To get the normal palette, the editor window has to be e.g. has to be put into background and then back into the front
again. 

In addition, during editing a synoptic, the GWDU editor occasionally crashes with ’segmentation fault–core dumped’
for no apparent reason
when pressing ’Accept’ after editing a display element. 
Stack trace from core dump follows: 

Core was generated by ‘/gsaf/gwdu/bin/sun5/GWDU CCU 60000014 60006656 WDU_GROUND_SYNOPTIC_DIS-
PLAY svfb’. 
Program terminated with signal 9, Killed. 
(gdb) where 
#0 0x2f80d8 in VGdgdfarg_value () 
#1 0x94d74 in CloseDgEditCB () 
#2 0x39ae00 in ActivateCommon () 
#3 0x497388 in HandleActions () 
#4 0x497ec8 in _XtTranslateEvent () 
#5 0x47b85c in DispatchEvent () 
#6 0x47bf2c in DecideToDispatch () 
#7 0x47bffc in XtDispatchEvent () 
#8 0x47c324 in XtAppMainLoop () 
#9 0x101900 in main () 
  
Workaround:

Do not start GWDU on the mashine where GWDU is displayed together with the Netscape Communicator! 
Before starting the the GWDU, quit all Netscape Communicator processes/tools. The same is valid for the acrobat reader
version 3 and 4. 

[5] COL–RIBRE–SPR–9638
CGS: Testnode 2 disappears during test 
  
Description:
1) It happened 3 to 4 times during the last 3 weeks that TN2 disappeared during test. The effect has been noticed that
sending a command
to CC_Bus2 via TN2 is not possible anymore (no ready message in synoptic display, ’Cannot contact testnode’ in HLCL
command window). 
After starting TSCV window a message window appears: 
’Failed to check TSP status on node TN2’ 
Verifying TSCV window shows ’No contact’ for TES_02. 
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2)Shutting down the complete ETM and the EGSE by APs result in some error messages in message handler ’cannot
stop AP’ also on other
TNs. 
Stopping the test configuration with TSCV results in error messages like ’Test node TES_01 rejected the stop request’
or ’Failed to stop test
on node TES_03’. 

Sometimes 2) happened without occurance of 1). 

A complete TSCV and CGS shutdown is now necessary to recover the system. It takes approx. 1,5 hours to get back
to the state before the
error occured. 

The message handler log file is attached (see apmws8.03–Apr–01.07:49:22.log).
  
Workaround:

Increase physical memory (RAM) of test nodes to 256 MB as a minimum. 
Increase MAXDSIZE parameter fo HP_UX.

[6] COL–RIBRE–SPR–9925
CGS: wrong access permissions for file opcodes_.a 
  
Description:
When installing CGS 4.5 using the script install_gsaf, the following error is reported: 

# cgs/util/common/install_gsaf 

Installation of CGS products [GSAF version 4.4.0] 
================================================ 

This script configures the CGS procured products. 

CGS is already installed and registered on ”18.06.2001 11:47:01 ” 

Do you want to re–install this product (y|n) ? [n] y 

CGS installation 
–––––––––––––––– 

Please wait while copying many files (see ”ps –ef | grep cp”)......cp: cannot create /export/sivq_cgs/gsaf/opcodes_.a:
Permission denied 

Verification of the access rights gave: 

cgsadmin@sivq–dbs] (export/sivq_cgs/gsaf) 67 : ls –al cgs/lib/cgs_api/sun5/EXT_ICD.sun.source_tree/css/kernel/
common_sources/ 
total 44 
drwxr–xr–x 2 cgsadmin cgs 512 Jun 18 11:45 . 
drwxr–xr–x 3 cgsadmin cgs 512 Jun 1 17:07 .. 
–r––r––r–– 1 cgsadmin cgs 19956 Jun 18 11:45 opcodes_.a 
[cgsadmin@sivq–dbs] (export/sivq_cgs/gsaf) 68 : 
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Workaround:

The missing access rights for ’write’ only affect the removal of the file 
resp. the re–installation of the CGS_API. 

To overcome this problem, change permissions manually before removal/re–installation of the CGS_API: 

as user cgsadmin: 

chmod u+w $CGS_HOME/lib/cgs_api/sun5/EXT_ICD.sun.source_tree/css/kernel/common_sources/opcodes_.a

[7] COL–RIBRE–SPR–10026
FWDU: FWDU not failsafe against Oracle error 
  
Description:
If the FWDU and GWDU editors are open for some time and some work has been done, and if Oracle crashes or is shut-
down, all work of the
editors is lost and cannot be saved. Moreover, the user has to kill the applications because they cannot be stopped normal-
ly because the
error message ’work not yet saved’ comes up which is very sarcastic. 

Other editors in the CGS range have the possibility to save the work to file system files (CLS, CSS). At least this possibil-
ity should be availabe
also in the FWDU and GWDU. Even if a warning is sent e. g. for shutting down Oracle, the saving of a complex FWDU
picture lasts about 10
minutes, so that the user has no chance to save the picture in time if a message appears ’Oracle will be shut down in 1
minute’. 

The problem arose when Oracle has been shutdown to enable the tracing for performance investigations. Maybe this
tracing can be switched
on easier on–line.
  
Workaround:

In case of Oracle problems the user can perform the (failing) save action and afterwards (before killing the FWDU pro-
cesses) save the ASCII
file from the temporary data directory into the permanent $FWDU_HOME/data directory. When Oracle is available
later on the user can use
the FWDU import functionality to re–import the display from the file into the database.

[8] COL–RIBRE–SPR–10138
MDA: Oracle system password missing in inst_a_init_mdb 
  
Description:
The automatic installation and initialization program for the MDB inst_a_init_mdb calls the scripts install_mdb and
initialize_mdb with the
files install_mdb.input and initialize_mdb.input respectively. In the file install_mdb.input, as the last entry, the Oracle
system password is
missing. Without this system password, the script will cycle in an endless loop. The entry is not only missing in the file,
it is also missing in
the installation procedure description of this function. All scripts and files are located in the directory
$GSAF_HOME/mda/config/mdb/install/admin_scripts. The installation procedure mentions this in chapter 5.1.6 on
page 72.
  



COL–RIBRE–TN–1197
Issue: 10 –
Date: 18.4.2002

Page: 29

Space Infrastructure

astrium

Workaround:

In the file install_mdb.input in $GSAF_HOME/mda/config/mdb/install/admin_scripts, add the oracle system password
at the end on an own
line – amongst all the other edit actions (change the contents of the delivered file to your own needs). After that the script
inst_a_init_mdb
should work as expected.

[9] COL–RIBRE–SPR–11053
MDA: bde_load/bde_store does not work 
  
Description:
There are references (possibly hardcoded) in bde_load to $HOME/bde/scripts and $HOME/bde/scripts/temp, even
though the environment is
set to find the bde software under $MDA_HOME/util/bde. 
The bde application should reside strictly under $MDA_HOME, while the user data should be strictly under $HOME.

The following test environment was used. 
buffy 111 % bde_load 
SVF environment set 
BDE_CFG = /homes/svfm2/bde/input/diag_batch_config.dat 
BDE_CFG_NAME = diag_batch_config 

BDE_HOME = /homes/svfm2/bde 
BDE_DATA = /homes/svfm2/bde/input 
BDE_REPORTS = /homes/svfm2/bde/reports 

BDE_SCRIPTS = /homes/svfm2/mda/util/bde/scripts 
BDE_TEMP_DIR = /homes/svfm2/mda/util/bde/scripts/temp 

CTL = /homes/svfm2/mda/config/mdb/install/dadi_export/bde_control_files 
DAT = /homes/svfm2/bde/input 
LOG = /homes/svfm2/bde/reports/sqlloader/log 
DIS = /homes/svfm2/bde/reports/sqlloader/dis 
BAD = /homes/svfm2/bde/reports/sqlloader/bad 

logifle output 
... 
\ISS\USGS\GV\DIAG\DISPLAYS\RTIOP_02 EntryIncluded 
diag_batch_config_T_WDU_GR_SYNOPTIC_DISPLAYS_160107080 T_WDU_GR_SYNOPTIC_DISPLAYS
PATHNAME
\ISS\USGS\GV\DIAG\DISPLAYS\TLS_01 EntryIncluded 
diag_batch_config_T_WDU_GR_VARIABLE_REF_LISTS T_WDU_GR_VARIABLE_REF_LISTS PATHNAME

–––––––––––––––––––––––––––––––––––––––– 

Loader parameter files generated 

unable to open file ”/homes/sip4adm/bde/scripts/bde_load.sql” 

Apparently there is a hardcoded reference that looks for scripts in $HOME/bde/scripts and also for $HOME/bde/scripts/
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temp 

Workaround is to copy the bde software from $MDA_HOME/util/bde/scripts/* to $HOME/bde/scripts to satisfy the
missing references. 
  
Workaround:

Workaround is to copy the bde software from $MDA_HOME/util/bde/scripts/* to $HOME/bde/scripts to satisfy the
missing references. 

[10] COL–RIBRE–SPR–11263
MDA: I_MDB import does not find import file in home directory 
  
Description:
Into an empty instance a system tree should be imported. The system tree export file SYS_TREE_V8_MASTER.export
was located in the home
directory of the executing user. The export attempt was interrupted by the error message 
58 : more LOG–020225–4984.imp 

Connected to: Oracle7 Server Release 7.3.4.4.0 – Production 
PL/SQL Release 2.3.4.4.0 – Production 

IMP–00002: failed to open /tmp/imp_5017.SYS_TREE_V8_MASTER.export.0 for read 
IMP–00021: operating system error – error code (dec 2, hex 0x2) 
Import terminated successfully with warnings. 

The file imp_5017.SYS_TREE_V8_MASTER.export.0 existed in the directory /tmp as a link to the file
./SYS_TREE_V8_MASTER.export, which
in turn did not exist. 
lrwxrwxrwx 1 supvisor cgs 27 Feb 25 14:55 imp_1577.SYS_TREE_V8_MASTER.export.0 –>
./SYS_TREE_V8_MASTER.export 

There is probably an error if the file is located in the home directory and the user does not enter the full pathname. 
  
Workaround:

The bug does not appear if always the complete pathname of the import file is entered. This is also possible with environ-
ment variables, e.
g. $HOME. Probably the ~ (tilde) is not possible.


